Release Notes for Nuke and Hiero
12.2v8

Copyright © 2021 The Foundry Visionmongers Ltd.

Release Date

29 July 2021

Warning: As a result of the current COVID-19 lockdown here in the UK, Foundry cannot
guarantee that our usual high standards of QA have been applied to Nuke's monitor output
functionality, including VR headset support, in this release.

Qualified Operating Systems

« macOS Mojave (10.14) or macOS Catalina (10.15)

Note: We recommend macOS Mojave customers update to 10.14.6 to take advantage of
performance enhancements.

* Windows 10 (64-bit)
« CentOS 74, 7.5, and 7.6 (64-bit)

Note: The VFX Platform 2019 upgrade includes library versions that are only compatible with
CentOS 7.4, or later.

Other operating systems may work, but have not been fully tested.
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If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements.

NVIDIA

An NVIDIA GPU with compute capability 3.0 (Kepler) or above. A list of the compute capabilities of NVIDIA
GPUs is available at https://developer.nvidia.com/cuda-gpus

Note: The compute capability is a property of the GPU hardware and can't be altered by a
software update.

With graphics drivers capable of running CUDA 10.1 or above. On Windows and Linux, CUDA graphics
drivers are bundled with the regular drivers for your NVIDIA GPU. Driver versions 418.96 (Windows) and
418.39 (Linux), or above are required. See https://www.nvidia.com/Download/Find.aspx for more
information.

Note: We recommend using the latest graphics drivers, where possible, regardless of operating
system.

AMD

Note: Bit-wise equality between GPU and CPU holds in most cases, but for some operations
there are limitations to the accuracy possible with this configuration.

« On Windows and Linux, an AMD GPU from the following list:

Note: Other AMD GPUs may work, but have not been fully tested.

« Radeon™ RX 480

« Radeon™ Pro WX 7100
« Radeon™ Pro WX 9100
« Radeon™ Pro WX 8200


https://developer.nvidia.com/cuda-gpus
https://www.nvidia.com/Download/Find.aspx
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« Radeon™ Pro W5700

Note: For information on the recommended driver for each GPU, see
https://www.amd.com/en/support

» On Mac, AMD GPUs are supported on any late 2013 Mac Pro, mid 2015 MacBook Pros onward, and late
2017 iMac Pros.

Warning: Although AMD GPUs are enabled on other Mac models, they are not officially
supported and used at your own risk.

Multi-GPU Processing

Nuke's GPU support includes an Enable multi-GPU support option. When enabled in the preferences,
GPU processing is shared between the available GPUs for extra processing speed.

Note: Multi-GPU processing is only available for identical GPUs in the same machine. For
example, two NVIDIA GeForce GTX 1080s or two AMD Radeon™ Pro WX 9100s.

New Features

HieroPlayer is now a free annual subscription with your Nuke or NukeX license. Simply renew your existing
Nuke or NukeX license to receive your HieroPlayer entitlement or fill in the on-demand form.

HieroPlayer is an artist desktop review tool that lets you play back shots or a sequence and compare
versions of renders quickly, letting you easily see your work in the context of the VFX timeline.

See HieroPlayer Free with Nuke for more information.

Feature Enhancements

« BUG ID 481030 - HieroPlayer now supports track blending in the same way as Nuke Studio and Hiero.
See Blending Tracks on the Timeline for more information.


https://www.amd.com/en/support
https://campaigns.foundry.com/hiero-player-free-with-nuke
https://learn.foundry.com/nuke/content/timeline_environment/managetimelines/track_blending.html

Release Notes for Nuke and Hiero 12.2v8 |

« BUG ID 481534 - HieroPlayer now includes several new workspaces tailored to specific tasks, including
Flipbook Player, Reviewing, and Sync Session.

Bug Fixes
» BUG ID 282435 - HieroPlayer: Random shots on the timeline were occasionally locked.

« BUG ID 358709 - Documentation: A layer command was missing attributes in the Nuke Python
Developer's Guide for Channels.

« BUG ID 378555 - Localization: Playback during localization of source files did not perform as expected.

« BUG ID 427913 - Monitor Out: Looping a sequence occasionally skipped frames on the monitor and in
the timeline Viewer.

« BUG ID 428258 - Python: Commenting out the last line of code in the Script Editor caused Nuke to
become unresponsive.

« BUG ID 436068/43679 - Sync Review: Reviewing large projects referencing remote server footage was
sluggish and occasionally caused reconnection issues or the application to crash.

« BUG ID 440884 - Sync Review: Clicking the update button in a client session with Viewer A/B mode active
disconnected the client.

* BUG ID 444711 - Assert: Adding an Assert node between transforms broke concatenation.

* BUG ID 465300 - Read/Write: Certain Photo - JPEG encoded .mov files with non-standard format sizes
caused Nuke Studio to crash.

* BUG ID 466816 - Read/Write: Certain .mp4/.mov files caused Nuke to become unresponsive during
playback of the last frame.

* BUG ID 469260 - Read/Write: Failure to decode a frame from certain .mov/.mp4 files written with a
"non-intra” codec caused Nuke to become unresponsive.

* BUG ID 469710 - Read/Write: Certain .mov files caused Nuke Studio and Hiero to crash.

« BUG ID 473394 - Sync Review: Client sessions occasionally disconnected from the host when reviewing in
large projects.

« BUG ID 473395 - Sync Review: Pushing changes from a client to the host occasionally disconnected or
caused the application to crash.

« BUG ID 473399 - Viewing the output of certain scripts including a Merge (under), Shuffle, and Write node
caused Nuke to crash.

« BUG ID 475236 - Project Bin: Deleting bin items from certain Nuke Studio projects was occasionally slow.
« BUG ID 476360 - C_Stitcher: The output of C_Stitcher was re-rendered for every scanline in the Viewer.

« BUG ID 477320 - Python: Some files were missing from the Flipbooking with External Applications
pyQtExamples directory.

« BUG ID 481790 - Localization: Opening a project containing localized files caused Nuke Studio to
become unresponsive.
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« BUG ID 482494 - HieroPlayer: Saving a custom workspace over a default workspace and assigning a
different keyboard shortcut caused the order of existing keyboard shortcuts to display incorrectly.

« BUG ID 483964 - Documentation: The Shotgun example in the Python Developers Guide referenced
Python 3, rather than Python 2.7.

New Known Issues Specific to Nuke 12.2

This section covers new known issues and gives workarounds for them, where appropriate.

Note: Changes to the way motion vectors are calculated in Nuke 12.2 cause any node using the
Local option for motion estimation, such as Kronos and VectorGenerator, to render slightly
different vectors when compared to legacy versions of Nuke. The default Regularized motion
estimation method is unaffected.

« BUG ID 474957 - Monitor Output: The AJA T-Tap device does not currently work with Nuke.

* BUG ID 472462 - Frame Server: Nuke frame server processes do not currently free RAM after completing
arender.

* BUG ID 472336 - Linux only: Adding certain MOV/QuickTime files containing audio to timeline causes
Nuke Studio to crash.

* BUG ID 471373 - macOS Nuke Indie only: C_STMap is incorrectly recognized as a custom plug-in and
cannot be loaded.

* BUG ID 470465 - Preferences: The Performance > Hardware > disable blink cache control has a
misleading label and tooltip.

* BUG ID 468956 - Read/Write: Importing .aaf files with the file browser Preview panel open causes Nuke
Studio to crash.

* BUG ID 466754 - USD: Enabling read from file in a Camera or Axis node's Properties and then clicking
No in the popup does not disable read from file as expected.

« BUG ID 466720 - USD: Copy/pasting a .usd file from a browser into the Node Graph adds a / (forward
slash) to the file path and displays a No such file or directory error.
As a workaround, delete the / and press enter to display the import dialog as normal.

* BUG ID 466485 - Linux only: Nuke can not read .r3d files without CUDA libraries available on the
machine.
As a workaround, you can manually install the CUDA libraries from NVIDIA, even if you don't have an
NVIDIA GPU installed.

* BUG ID 461944 - Python: Changing a Read node from an image sequence to a container file format
Pythonically causes Nuke to crash if the Read node has postage stamp set to a static frame.
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« BUG ID 460411 - Read/Write: Rereading a .mov encoded with mov32 settings using the file control in
legacy scripts causes Nuke to crash.

* BUG ID 460240 - masOS only: Existing export presets using the deprecated mov32 codecs cause Hiero to
crash on export.
As a workaround, recreate the preset in a Hiero 12.2 release

« BUG ID 460038 - Particles: Secondary particles emitted from other particles do not render as expected.

« BUG ID 459859 - ACES: Nuke Studio incorrectly allows artists to alter the R3D IPP2 colorspaces in Read
nodes using IPP2 Custom selection, which results in Half Float ACES Linear colorspace mismatches
between Nuke Studio and Nuke.

* BUG ID 459609 - USD: The Scenegraph does not automatically expand the first layer of items when
loaded for the first time.

* BUG ID 448524 - macOS only: The resolution restriction informational message for Nuke Indie contains
incorrect text.

« BUG ID 444347 - Export: Presets that rely on mov32 do not populate the Content field in the Export
dialog.
* BUG ID 443296 - Windows only: The Nuke Indie icon is incorrect.

« BUG ID 442165 - MOV: Writing out .mov files using the H.264 codec at resolutions above the 4K limit
imposed by the codec causes Nuke to crash.

* BUG ID 441979 - USD: Deselecting a group in the USD importer and then enabling view entire
scenegraph does not load the group.

* BUG ID 441555 - USD: Clicking Cancel in the USD import dialog and then enabling view entire
scenegraph does not load the .usd file as expected.

* BUG ID 441439 - R3D: Red decode CPU performance is slower in Nuke 12.2 compared to 12.1 builds.

* BUG ID 440943 - USD: Expanding parent and children groups in the scenegraph manually does not create
the horizontal scroll bar correctly.
As a workaround, right-click and select expand all to display the scroll bar.

* BUG ID 440057 - Roaming: Hiero license roaming with a Nuke Studio license stack is not working as
expected.
As a workaround, launch Nuke Studio and select License > Roaming and then set the Workspace to
Conforming.

* BUG ID 439856 - Sync Review: Client sessions do not cache sequences as expected when the Viewer A/B
mode is active on the Host before the Client connects.

* BUG ID 439011 - ApplyMaterial: Selecting filter > name and then clicking choose incorrectly displays
Load state icons.

« BUG ID 439002 - ApplyMaterial: Selecting filter > name and then clicking choose allows editing of the
read-only names in the scenegraph.

« BUG ID 436560/436551 - Sync Review: The formatting in the Sync Session panel and Host and Connect
dialogs is inconsistent.
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* BUG ID 434956 - USD: Columns in the Scenegraph tab can only be rearranged once.

* BUG ID 434574 - File Formats Update: Reading .mxf files in the HybridLogGamma colorspace defaults
to linear incorrectly.

« BUG ID 432438 - Vertex UV values are occasionally displayed incorrectly for .abc and .usd files.

« BUG ID 430779 - File Formats Update: All deprecated IPP2 .r3d colorspaces appear the same as current
colorspaces.

* BUG ID 430760 - File Formats Update: DRAGONCcolor2 and REDcolor4 use the same IPP2 .r3d colorspace.

* BUG ID 429788 - macOS only: Legacy mov32 presets are no longer retained, choosing a preset always
displays the Don't show this message dialog.

« BUG ID 426901 - File Formats Update: In IPP2 Custom mode, enabling the Use GPU checkbox displays
grading controls from the IPP2 Pipeline incorrectly.

« BUG ID 425200 - Read/Write: Legacy Write node Motion JPEG A/B files do not display the Quality
control with mov64 selected as the encoder.

« BUG ID 424070 - RIP: Ops requesting unused inputs occasionally prevent images being released from the
device cache.



Release Notes for Nuke and Hiero 12.2v8 |

Developer Notes

As Nuke develops, we sometimes have to make changes to the APl and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time APl and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plug-ins and/or make changes to the source code.

Release Type Example Compatibility Recompile Rewrite
Version 12.0v1 to 12.0v2 APl and ABI

Point 12.0v1 to 12.1v1 API

Major 12.0v1 to 13.0v1 -

Additionally, node Class() names occasionally change between major releases. While these changes do not
affect legacy scripts, you may not get the results you were expecting if a node class has been modified.
The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class names and is
located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from CameraShake?2
to CameraShake3. In the toolbars.py file for the two releases, the entries for the CameraShake node
appear as follows:

m.addCommand ("CameraShake", "nuke.createNode (\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand ("CameraShake", "nuke.createNode (\"CameraShake3\")",

icon="CameraShake.png")
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12.2v7

Copyright © 2021 The Foundry Visionmongers Ltd.

Release Date

10 June 2021

Warning: As a result of the current COVID-19 lockdown here in the UK, Foundry cannot
guarantee that our usual high standards of QA have been applied to Nuke's monitor output
functionality, including VR headset support, in this release.

Qualified Operating Systems

« macOS Mojave (10.14) or macOS Catalina (10.15)

Note: We recommend macOS Mojave customers update to 10.14.6 to take advantage of
performance enhancements.

* Windows 10 (64-bit)
« CentOS 74, 7.5, and 7.6 (64-bit)

Note: The VFX Platform 2019 upgrade includes library versions that are only compatible with
CentOS 7.4, or later.

Other operating systems may work, but have not been fully tested.
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If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements.
NVIDIA

An NVIDIA GPU with compute capability 3.0 (Kepler) or above. A list of the compute capabilities of NVIDIA
GPUs is available at https://developer.nvidia.com/cuda-gpus

Note: The compute capability is a property of the GPU hardware and can't be altered by a
software update.

With graphics drivers capable of running CUDA 10.1 or above. On Windows and Linux, CUDA graphics
drivers are bundled with the regular drivers for your NVIDIA GPU. Driver versions 418.96 (Windows) and
418.39 (Linux), or above are required. See https://www.nvidia.com/Download/Find.aspx for more
information.

Note: We recommend using the latest graphics drivers, where possible, regardless of operating
system.

AMD

Note: Bit-wise equality between GPU and CPU holds in most cases, but for some operations
there are limitations to the accuracy possible with this configuration.

« On Windows and Linux, an AMD GPU from the following list:

Note: Other AMD GPUs may work, but have not been fully tested.

« Radeon™ RX 480

« Radeon™ Pro WX 7100
« Radeon™ Pro WX 9100
« Radeon™ Pro WX 8200

10
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« Radeon™ Pro W5700

Note: For information on the recommended driver for each GPU, see
https://www.amd.com/en/support

» On Mac, AMD GPUs are supported on any late 2013 Mac Pro, mid 2015 MacBook Pros onward, and late
2017 iMac Pros.

Warning: Although AMD GPUs are enabled on other Mac models, they are not officially
supported and used at your own risk.

Multi-GPU Processing

Nuke's GPU support includes an Enable multi-GPU support option. When enabled in the preferences,
GPU processing is shared between the available GPUs for extra processing speed.

Note: Multi-GPU processing is only available for identical GPUs in the same machine. For
example, two NVIDIA GeForce GTX 1080s or two AMD Radeon™ Pro WX 9100s.

New Features

There are no new features in this release.

Feature Enhancements

« BUG ID 140786/148736/407810 - Backdrop: Creating a Backdrop node now places the backdrop near the
mouse pointer's location if no other node is selected.

Bug Fixes
* BUG ID 167882 - WriteGeo: Exporting an .fbx file with an upper case file extension did not work as
expected.

« BUG ID 360410 - Selecting File > New Comp in Nuke did not carry command-line arguments, such as --
safe, over to the new Nuke script.


https://www.amd.com/en/support
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* BUG ID 437414 - Windows only: Pressing V to display available versions on an offline shot caused Nuke
Studio to crash.

* BUG ID 446363 - Node Properties undo/redo/reset controls were disabled when making adjustments
with a Shuffle2 node upstream.

« BUG ID 453576/472075 - Tags: Selecting a new icon for a tag did not update the tag icon in the Viewer
as expected.

« BUG ID 456647 - Ul: Resizing the Node Graph map to 0 caused nodes in the Node Graph to disappear.
« BUG ID 458752 - Licensing: Nuke 12.2 did not display licensing errors as expected.

« BUG ID 467080 - Export: Re-exporting comps occasionally displayed an out of frame range warning in
the Viewer after scanning for versions and then versioning up.

« BUG ID 469046 - Soft Effects: Some effects were displayed in different colors between Nuke Studio and
Hiero or HieroPlayer.

« BUG ID 470096 - Python: Clicking the Load column for items in a custom sceneView_Knob cleared the
object name in the Scenegraph.

* BUG ID 470388 - ABC: Deselecting locator items in an Alembic ReadGeo import and then clicking Create
all-in-one node caused the import of all objects to fail.

« BUG ID 470531 - Retiming: Attempting to retime a clip on an odd number frame at clip-level, resulted in
frame offsets in exported shots.

* BUG ID 470569 - Retiming: Exporting a shot with frame handles beyond the source clip handle range and
then clicking Build Track from Export Tag reimported the shot with an offset if the source clip did not
start at frame 1.

* BUG ID 470881 - Text: The clip to control didn't handle black outside correctly.

« BUG ID 470999 - AddChannels: The format_size knob didn't handle black outside correctly.

* BUG ID 471672 - Viewers: Disabling tracks in a sequence did not update the timeline Viewer as expected.
* BUG ID 473324 - WriteGeo: File format detection behaved differently to the Write node.

» BUG ID 473689 - Sync Review: Importing files during a Sync Review session occasionally caused Nuke
Studio to crash.

* BUG ID 475297 - Viewers: Selecting Audio and Video in the timeline Viewer settings did not display the
audio waveform.

« BUG ID 475778 - Group: Copying/pasting or loading Group nodes from ToolSets placed the node
incorrectly in the Node Graph.

« BUG ID 476091 - Export: Re-exporting comps and then opening the new comp occasionally displayed a
no such file or directory error.

New Known Issues Specific to Nuke 12.2

This section covers new known issues and gives workarounds for them, where appropriate.

12
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Note: Changes to the way motion vectors are calculated in Nuke 12.2 cause any node using the
Local option for motion estimation, such as Kronos and VectorGenerator, to render slightly
different vectors when compared to legacy versions of Nuke. The default Regularized motion
estimation method is unaffected.

* BUG ID 475140 - Documentation: The Hiero Python Developer's Guide does not currently ship with Nuke
builds.

« BUG ID 474957 - Monitor Output: The AJA T-Tap device does not currently work with Nuke.

* BUG ID 472462 - Frame Server: Nuke frame server processes do not currently free RAM after completing
arender.

* BUG ID 472336 - Linux only: Adding certain MOV/QuickTime files containing audio to timeline causes
Nuke Studio to crash.

* BUG ID 471373 - macOS Nuke Indie only: C_STMap is incorrectly recognized as a custom plug-in and
cannot be loaded.

« BUG ID 470465 - Preferences: The Performance > Hardware > disable blink cache control has a
misleading label and tooltip.

* BUG ID 468956 - Read/Write: Importing .aaf files with the file browser Preview panel open causes Nuke
Studio to crash.

* BUG ID 466754 - USD: Enabling read from file in a Camera or Axis node's Properties and then clicking
No in the popup does not disable read from file as expected.

« BUG ID 466720 - USD: Copy/pasting a .usd file from a browser into the Node Graph adds a / (forward
slash) to the file path and displays a No such file or directory error.
As a workaround, delete the / and press enter to display the import dialog as normal.

* BUG ID 466485 - Linux only: Nuke can not read .r3d files without CUDA libraries available on the
machine.
As a workaround, you can manually install the CUDA libraries from NVIDIA, even if you don't have an
NVIDIA GPU installed.

* BUG ID 465300 - Read/Write: Certain Photo - JPEG encoded .mov files with non-standard format sizes
cause Nuke Studio to crash.

« BUG ID 461944 - Python: Changing a Read node from an image sequence to a container file format
Pythonically causes Nuke to crash if the Read node has postage stamp set to a static frame.

« BUG ID 460411 - Read/Write: Rereading a .mov encoded with mov32 settings using the file control in
legacy scripts causes Nuke to crash.

* BUG ID 460240 - masOS only: Existing export presets using the deprecated mov32 codecs cause Hiero to
crash on export.
As a workaround, recreate the preset in a Hiero 12.2 release

« BUG ID 460038 - Particles: Secondary particles emitted from other particles do not render as expected.

13
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* BUG ID 459859 - ACES: Nuke Studio incorrectly allows artists to alter the R3D IPP2 colorspaces in Read
nodes using IPP2 Custom selection, which results in Half Float ACES Linear colorspace mismatches
between Nuke Studio and Nuke.

« BUG ID 459609 - USD: The Scenegraph does not automatically expand the first layer of items when
loaded for the first time.

« BUG ID 448524 - macOS only: The resolution restriction informational message for Nuke Indie contains
incorrect text.

« BUG ID 444347 - Export: Presets that rely on mov32 do not populate the Content field in the Export
dialog.

* BUG ID 443296 - Windows only: The Nuke Indie icon is incorrect.

* BUG ID 442165 - MOV: Writing out .mov files using the H.264 codec at resolutions above the 4K limit
imposed by the codec causes Nuke to crash.

* BUG ID 441979 - USD: Deselecting a group in the USD importer and then enabling view entire
scenegraph does not load the group.

» BUG ID 441555 - USD: Clicking Cancel in the USD import dialog and then enabling view entire
scenegraph does not load the .usd file as expected.

* BUG ID 441439 - R3D: Red decode CPU performance is slower in Nuke 12.2 compared to 12.1 builds.

* BUG ID 440943 - USD: Expanding parent and children groups in the scenegraph manually does not create

the horizontal scroll bar correctly.
As a workaround, right-click and select expand all to display the scroll bar.

* BUG ID 440884 - Sync Review: Clicking the update button in a Client session with Viewer A/B mode
active disconnects the Client.

« BUG ID 440057 - Roaming: Hiero license roaming with a Nuke Studio license stack is not working as
expected.
As a workaround, launch Nuke Studio and select License > Roaming and then set the Workspace to
Conforming.

« BUG ID 439856 - Sync Review: Client sessions do not cache sequences as expected when the Viewer A/B
mode is active on the Host before the Client connects.

« BUG ID 439011 - ApplyMaterial: Selecting filter > name and then clicking choose incorrectly displays
Load state icons.

« BUG ID 439002 - ApplyMaterial: Selecting filter > name and then clicking choose allows editing of the
read-only names in the scenegraph.

« BUG ID 436560/436551 - Sync Review: The formatting in the Sync Session panel and Host and Connect
dialogs is inconsistent.

* BUG ID 434956 - USD: Columns in the Scenegraph tab can only be rearranged once.

* BUG ID 434574 - File Formats Update: Reading .mxf files in the HybridLogGamma colorspace defaults
to linear incorrectly.

« BUG ID 432438 - Vertex UV values are occasionally displayed incorrectly for .abc and .usd files.

14
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* BUG ID 430779 - File Formats Update: All deprecated IPP2 .r3d colorspaces appear the same as current
colorspaces.

* BUG ID 430760 - File Formats Update: DRAGONCcolor2 and REDcolor4 use the same IPP2 .r3d colorspace.

* BUG ID 429788 - macOS only: Legacy mov32 presets are no longer retained, choosing a preset always
displays the Don't show this message dialog.

« BUG ID 426901 - File Formats Update: In IPP2 Custom mode, enabling the Use GPU checkbox displays
grading controls from the IPP2 Pipeline incorrectly.

« BUG ID 425200 - Read/Write: Legacy Write node Motion JPEG A/B files do not display the Quality
control with mov64 selected as the encoder.

« BUG ID 424070 - RIP: Ops requesting unused inputs occasionally prevent images being released from the
device cache.

15
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Developer Notes

As Nuke develops, we sometimes have to make changes to the APl and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time APl and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plug-ins and/or make changes to the source code.

Release Type Example Compatibility Recompile Rewrite
Version 12.0v1 to 12.0v2 APl and ABI

Point 12.0v1 to 12.1v1 API

Major 12.0v1 to 13.0v1 -

Additionally, node Class() names occasionally change between major releases. While these changes do not
affect legacy scripts, you may not get the results you were expecting if a node class has been modified.
The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class names and is
located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from CameraShake?2
to CameraShake3. In the toolbars.py file for the two releases, the entries for the CameraShake node
appear as follows:

m.addCommand ("CameraShake", "nuke.createNode (\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand ("CameraShake", "nuke.createNode (\"CameraShake3\")",

icon="CameraShake.png")

16
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12.2v6

Copyright © 2021 The Foundry Visionmongers Ltd.

Release Date

25 March 2021

Warning: As a result of the current COVID-19 lockdown here in the UK, Foundry cannot
guarantee that our usual high standards of QA have been applied to Nuke's monitor output
functionality, including VR headset support, in this release.

Qualified Operating Systems

« macOS Mojave (10.14) or macOS Catalina (10.15)

Note: We recommend macOS Mojave customers update to 10.14.6 to take advantage of
performance enhancements.

* Windows 10 (64-bit)
« CentOS 74, 7.5, and 7.6 (64-bit)

Note: The VFX Platform 2019 upgrade includes library versions that are only compatible with
CentOS 7.4, or later.

Other operating systems may work, but have not been fully tested.
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If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements.
NVIDIA

An NVIDIA GPU with compute capability 3.0 (Kepler) or above. A list of the compute capabilities of NVIDIA
GPUs is available at https://developer.nvidia.com/cuda-gpus

Note: The compute capability is a property of the GPU hardware and can't be altered by a
software update.

With graphics drivers capable of running CUDA 10.1 or above. On Windows and Linux, CUDA graphics
drivers are bundled with the regular drivers for your NVIDIA GPU. Driver versions 418.96 (Windows) and
418.39 (Linux), or above are required. See https://www.nvidia.com/Download/Find.aspx for more
information.

Note: We recommend using the latest graphics drivers, where possible, regardless of operating
system.

AMD

Note: Bit-wise equality between GPU and CPU holds in most cases, but for some operations
there are limitations to the accuracy possible with this configuration.

« On Windows and Linux, an AMD GPU from the following list:

Note: Other AMD GPUs may work, but have not been fully tested.

« Radeon™ RX 480

« Radeon™ Pro WX 7100
« Radeon™ Pro WX 9100
« Radeon™ Pro WX 8200
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« Radeon™ Pro W5700

Note: For information on the recommended driver for each GPU, see
https://www.amd.com/en/support

» On Mac, AMD GPUs are supported on any late 2013 Mac Pro, mid 2015 MacBook Pros onward, and late
2017 iMac Pros.

Warning: Although AMD GPUs are enabled on other Mac models, they are not officially
supported and used at your own risk.

Multi-GPU Processing

Nuke's GPU support includes an Enable multi-GPU support option. When enabled in the preferences,
GPU processing is shared between the available GPUs for extra processing speed.

Note: Multi-GPU processing is only available for identical GPUs in the same machine. For
example, two NVIDIA GeForce GTX 1080s or two AMD Radeon™ Pro WX 9100s.

New Features

Sync Review is no longer a beta feature and now includes all the actions needed on a Review Session, such
as changes in the timeline, importing new footage, or creating new soft effects. Sync Review for
NukeStudio, Hiero, and HieroPlayer enable teams to collaborate and continue working together towards a
shared vision of the final image.

HieroPlayer now includes the same annotations capabilities as Nuke Studio and Hiero, providing greater
creative control during review sessions.

Previously, only the playback controls, versioning system and annotations were updated during the
session, and editorial changes required a manual push to update other participants' sessions. In this
release, most actions available in the timeline, Viewer, and Project bin are synced automatically during the
session including:
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« Changes in the Viewer: Layer and channel selection, the TC/TF frame slider option, Viewer guides, and
zoom in and out.

 Changes in the Timeline: Creating new tracks, renaming shots, adding or deleting soft effects, retimes
and transitions, changes to soft effects parameters, lock status of tracks, timming, and moving shots on
the timeline.

« Changes in the Project bin: Creating, renaming, moving or deleting project items, importing files,
creating new sequences, tags, and bins.

Feature Enhancements

« BUG ID 360412 - Annotations: Sequences exported from Nuke Studio and Hiero now have the option to
include burnt-in annotations. The export option is in the Transcode Image exporter under Effects and
Annotations > Include Annotations.

Bug Fixes

« BUG ID 137121 - Nuke crashed on start up if the disk cache location set in the Preferences was no
longer available.

« BUG ID 379806 - Python: The Hiero example file spreadsheet_csv_export.py did not work as expected.

« BUG ID 385696 - MergeMat: Copy/pasting a disabled MergeMat node to combine two Project3D nodes
caused Nuke to crash.

« BUG ID 401016 - Python: Calling Gizmo.filename() returned the value of a gizmo's file knob, rather than
the gizmo's location on disk.

« BUG ID 401881 - Windows only: Custom shortcuts using Shift and keypad numbers could not be
initialized.

* BUG ID 431846 - Shuffle2: Expression linking Input or Output Layer controls to a channel control in
another node caused Nuke to crash.

» BUG ID 431886 - Dragging files into the Project bin occasionally caused Nuke Studio and Hiero to
become unresponsive.

« BUG ID 433153 - Ul: The overlay and guides menu was occasionally disabled if it included custom guides.
« BUG ID 434560 - Python: PySide2 version 5.12.x did not support mocking in Nuke.

« BUG ID 437042 - Windows only: Nuke did not register Nuke scripts with an associated program when
installed.

« BUG ID 438360 - Documentation: The NDK documentation for Setting up Projects and Compilers was
out of date.

* BUG ID 447820 - Deep: Viewing a DeepMerge node with deep.front and deep.back set to inf values
caused Nuke to crash.
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» BUG ID 448363 - BlinkScript: Creating unsigned variables using uint displayed an error when GPU
acceleration was enabled.

« BUG ID 453738 - Sync Review: Deleting a clip from the Host Project panel did not update Client sessions
as expected.

* BUG ID 462887 - OCIO: Loading custom OCIO configs using the OCIO environment variable did not work
as expected.

« BUG ID 463633 - Colorspace: Exporting a script with various output colorspaces displayed an Invalid LUT
selected error.

« BUG ID 463791 - Soft Effects: Exporting a sequence containing Text effects on a separate video track set
clip to > bbox, rather than format.

* BUG ID 464372 - Python: Nuke could not load movWriter from an external version of Python.

* BUG ID 464455 - Python: The foundrySG_Example.py example and documentation did not work as
expected.

« BUG ID 464508 - Transform: Adjusting the scale control in a Transform node's Properties panel with
show overscan active in the Viewer settings caused Nuke to crash.

« BUG ID 464891 - Sync Review: Soft effect version names and numbers occasionally got out of sync
between sessions.

* BUG ID 465012 - Python: FnFilenameField.py was missing an import of QtCore.QEvent and displayed
errors in the console.

« BUG ID 465045 - Read/Write: The info bar overlay in Nuke Studio's Viewer displayed a one frame offset
for .mov and .mxf files compared to the source timecode.

« BUG ID 465375 - Tags: Selecting shots with tags on the timeline was slow compared to shots without
tags.

« BUG ID 466597 - Documentation: The Sample Scripts page was missing from the Nuke Python
Developer's Guide.

* BUG ID 467078 - Python: Renaming tags using the setName() function did not work as expected.
« BUG ID 468211 - Ul: Dragging widgets between panes occasionally named tabs incorrectly.

« BUG ID 468608 - User Knobs: User knobs created in the Project Settings were duplicated when a script
was closed and re-opened.

New Known Issues Specific to Nuke 12.2

This section covers new known issues and gives workarounds for them, where appropriate.

Note: Changes to the way motion vectors are calculated in Nuke 12.2 cause any node using the
Local option for motion estimation, such as Kronos and VectorGenerator, to render slightly
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different vectors when compared to legacy versions of Nuke. The default Regularized motion
estimation method is unaffected.

* BUG ID 471373 - macOS Nuke Indie only: C_STMap is incorrectly recognized as a custom plug-in and
cannot be loaded.

« BUG ID 470465 - Preferences: The Performance > Hardware > disable blink cache control has a
misleading label and tooltip.

* BUG ID 470388 - ABC: Deselecting locator items in an Alembic ReadGeo import and then clicking Create
all-in-one node causes the import of all objects to fail.
As a workaround, enable the view entire scenegraph control and then click the Load column for the
required objects.

« BUG ID 470096 - Python: Clicking the Load column for items in a custom sceneView_Knob clears the
object name in the Scenegraph.

* BUG ID 468956 - Read/Write: Importing .aaf files with the file browser Preview panel open causes Nuke
Studio to crash.

* BUG ID 466754 - USD: Enabling read from file in a Camera or Axis node's Properties and then clicking
No in the popup does not disable read from file as expected.

« BUG ID 466720 - USD: Copy/pasting a .usd file from a browser into the Node Graph adds a / (forward
slash) to the file path and displays a No such file or directory error.
As a workaround, delete the / and press enter to display the import dialog as normal.

* BUG ID 466485 - Linux only: Nuke can not read .r3d files without CUDA libraries available on the
machine.

As a workaround, you can manually install the CUDA libraries from NVIDIA, even if you don't have an
NVIDIA GPU installed.

* BUG ID 465300 - Read/Write: Certain Photo - JPEG encoded .mov files with non-standard format sizes
cause Nuke Studio to crash.

» BUG ID 461944 - Python: Changing a Read node from an image sequence to a container file format
Pythonically causes Nuke to crash if the Read node has postage stamp set to a static frame.

« BUG ID 460411 - Read/Write: Rereading a .mov encoded with mov32 settings using the file control in
legacy scripts causes Nuke to crash.

* BUG ID 460240 - masOS only: Existing export presets using the deprecated mov32 codecs cause Hiero to
crash on export.
As a workaround, recreate the preset in a Hiero 12.2 release

« BUG ID 460038 - Particles: Secondary particles emitted from other particles do not render as expected.

« BUG ID 459859 - ACES: Nuke Studio incorrectly allows artists to alter the R3D IPP2 colorspaces in Read
nodes using IPP2 Custom selection, which results in Half Float ACES Linear colorspace mismatches
between Nuke Studio and Nuke.
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« BUG ID 459609 - USD: The Scenegraph does not automatically expand the first layer of items when
loaded for the first time.

* BUG ID 448524 - macOS only: The resolution restriction informational message for Nuke Indie contains
incorrect text.

« BUG ID 444347 - Export: Presets that rely on mov32 do not populate the Content field in the Export
dialog.

» BUG ID 443296 - Windows only: The Nuke Indie icon is incorrect.

* BUG ID 442165 - MOV: Writing out .mov files using the H.264 codec at resolutions above the 4K limit
imposed by the codec causes Nuke to crash.

* BUG ID 441979 - USD: Deselecting a group in the USD importer and then enabling view entire
scenegraph does not load the group.

* BUG ID 441555 - USD: Clicking Cancel in the USD import dialog and then enabling view entire
scenegraph does not load the .usd file as expected.

* BUG ID 441439 - R3D: Red decode CPU performance is slower in Nuke 12.2 compared to 12.1 builds.

* BUG ID 440943 - USD: Expanding parent and children groups in the scenegraph manually does not create
the horizontal scroll bar correctly.
As a workaround, right-click and select expand all to display the scroll bar.

» BUG ID 440884 - Sync Review: Clicking the update button in a Client session with Viewer A/B mode
active disconnects the Client.

* BUG ID 440057 - Roaming: Hiero license roaming with a Nuke Studio license stack is not working as
expected.
As a workaround, launch Nuke Studio and select License > Roaming and then set the Workspace to
Conforming.

* BUG ID 439856 - Sync Review: Client sessions do not cache sequences as expected when the Viewer A/B
mode is active on the Host before the Client connects.

* BUG ID 439011 - ApplyMaterial: Selecting filter > name and then clicking choose incorrectly displays
Load state icons.

« BUG ID 439002 - ApplyMaterial: Selecting filter > name and then clicking choose allows editing of the
read-only names in the scenegraph.

« BUG ID 436560/436551 - Sync Review: The formatting in the Sync Session panel and Host and Connect
dialogs is inconsistent.

* BUG ID 434956 - USD: Columns in the Scenegraph tab can only be rearranged once.

* BUG ID 434574 - File Formats Update: Reading .mxf files in the HybridLogGamma colorspace defaults
to linear incorrectly.

* BUG ID 432438 - Vertex UV values are occasionally displayed incorrectly for .abc and .usd files.

* BUG ID 430779 - File Formats Update: All deprecated IPP2 .r3d colorspaces appear the same as current
colorspaces.

« BUG ID 430760 - File Formats Update: DRAGONcolor2 and REDcolor4 use the same IPP2 .r3d colorspace.
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* BUG ID 429788 - macOS only: Legacy mov32 presets are no longer retained, choosing a preset always
displays the Don't show this message dialog.

* BUG ID 426901 - File Formats Update: In IPP2 Custom mode, enabling the Use GPU checkbox displays
grading controls from the IPP2 Pipeline incorrectly.

« BUG ID 425200 - Read/Write: Legacy Write node Motion JPEG A/B files do not display the Quality
control with mov64 selected as the encoder.

« BUG ID 424070 - RIP: Ops requesting unused inputs occasionally prevent images being released from the
device cache.
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Developer Notes

As Nuke develops, we sometimes have to make changes to the APl and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time APl and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plug-ins and/or make changes to the source code.

Release Type Example Compatibility Recompile Rewrite
Version 12.0v1 to 12.0v2 APl and ABI

Point 12.0v1 to 12.1v1 API

Major 12.0v1 to 13.0v1 -

Additionally, node Class() names occasionally change between major releases. While these changes do not
affect legacy scripts, you may not get the results you were expecting if a node class has been modified.
The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class names and is
located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from CameraShake?2
to CameraShake3. In the toolbars.py file for the two releases, the entries for the CameraShake node
appear as follows:

m.addCommand ("CameraShake", "nuke.createNode (\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand ("CameraShake", "nuke.createNode (\"CameraShake3\")",

icon="CameraShake.png")
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Copyright © 2021 The Foundry Visionmongers Ltd.

Release Date

02 February 2021

Warning: As a result of the current COVID-19 lockdown here in the UK, Foundry cannot
guarantee that our usual high standards of QA have been applied to Nuke's monitor output
functionality, including VR headset support, in this release.

Qualified Operating Systems

« macOS Mojave (10.14) or macOS Catalina (10.15)

Note: We recommend macOS Mojave customers update to 10.14.6 to take advantage of
performance enhancements.

* Windows 10 (64-bit)
« CentOS 74, 7.5, and 7.6 (64-bit)

Note: The VFX Platform 2019 upgrade includes library versions that are only compatible with
CentOS 7.4, or later.

Other operating systems may work, but have not been fully tested.



Release Notes for Nuke and Hiero 12.2v5 |

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements.
NVIDIA

An NVIDIA GPU with compute capability 3.0 (Kepler) or above. A list of the compute capabilities of NVIDIA
GPUs is available at https://developer.nvidia.com/cuda-gpus

Note: The compute capability is a property of the GPU hardware and can't be altered by a
software update.

With graphics drivers capable of running CUDA 10.1 or above. On Windows and Linux, CUDA graphics
drivers are bundled with the regular drivers for your NVIDIA GPU. Driver versions 418.96 (Windows) and
418.39 (Linux), or above are required. See https://www.nvidia.com/Download/Find.aspx for more
information.

Note: We recommend using the latest graphics drivers, where possible, regardless of operating
system.

AMD

Note: Bit-wise equality between GPU and CPU holds in most cases, but for some operations
there are limitations to the accuracy possible with this configuration.

« On Windows and Linux, an AMD GPU from the following list:

Note: Other AMD GPUs may work, but have not been fully tested.

« Radeon™ RX 480

« Radeon™ Pro WX 7100
« Radeon™ Pro WX 9100
« Radeon™ Pro WX 8200
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« Radeon™ Pro W5700

Note: For information on the recommended driver for each GPU, see
https://www.amd.com/en/support

» On Mac, AMD GPUs are supported on any late 2013 Mac Pro, mid 2015 MacBook Pros onward, and late
2017 iMac Pros.

Warning: Although AMD GPUs are enabled on other Mac models, they are not officially
supported and used at your own risk.

Multi-GPU Processing

Nuke's GPU support includes an Enable multi-GPU support option. When enabled in the preferences,
GPU processing is shared between the available GPUs for extra processing speed.

Note: Multi-GPU processing is only available for identical GPUs in the same machine. For
example, two NVIDIA GeForce GTX 1080s or two AMD Radeon™ Pro WX 9100s.

New Features

There are no new features in this release.

Feature Enhancements

« BUG ID 138143/155591/164403/165692 - Node Graph: Dragging multiple nodes onto an input or output
now connects all nodes in the stack, rather than just the first node.

« BUG ID 393631 - Preferences: A new tooltip has been added to the Preferences under Panels > Node
Graph > Bounding Box Warning > enable. If this is enabled, Nuke performs extra processing steps to
identify problematic nodes, which may result in performance degradation.
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Bug Fixes

« BUG ID 156976 - Export: Process as Shot exports including soft effects or burn-ins did not match the
Viewer output.

« BUG ID 156237/407936 - Node Graph: Moving multiple node selections at certain zoom levels caused
node connections within the selection to change unexpectedly.

« BUG ID 418080 - LiveGroups: Exposing a large number of controls from nodes inside a LiveGroup caused
the Properties panel to become unstable.

* BUG ID 420684 - Backdrop: The font > color control did not work as expected.

* BUG ID 436088 - C_CamerSolver: Setting the Lens Type to Rectilinear with multiple camera inputs and
use GPU if available enabled rendered black frames.

* BUG ID 438947 - Node Graph: Pressing / (forward slash) to search the Node Graph by node name or class
did not highlight the previous search term.

« BUG ID 440783 - CaraVR: Attaching a Viewer to certain CaraVR nodes, such as C_Stitcher or C_Blender,
occasionally caused views or cameras to disappear at high resolutions.

« BUG ID 446419 - Sync Review: Pressing a channel keyboard shortcut twice, such as R, B, or A, did not
revert the channel states as expected.

* BUG ID 448577 - Sync Review: Unsuccessful connection to a Host caused Nuke Studio to become
unresponsive.

« BUG ID 450185 - Sync Review: Cloned soft effects were displayed as invalid in client sessions.

« BUG ID 457327/460279 - Linux only: Importing multiple .mxf, .ari, or .arx files into Nuke Studio or Hiero
caused the application to become unresponsive.

« BUG ID 458799 - Timeline Editing: Adding audio clips to sequences that already contained audio did not
work as expected.

* BUG ID 459394 - C_Stitcher: Checking Enable Stereo Stitch did not warp stereo images correctly.

* BUG ID 459638 - Create Comp: Comps created from long timeline shots were occasionally slow to open
in the Node Graph.

« BUG ID 460118 - Python: Exiting Nuke after adding a class to a menu displayed the Crash Reporter.

* BUG ID 461706 - FilelO Plug-ins: ARRI SDK plug-in version 6.2.3 caused Nuke Studio Non-Commercial to
crash.

« BUG ID 461760 - FilelO Plug-ins: Opening a project containing .ari or .mxf files in Nuke Studio Non
Commercial caused the application to crash.

* BUG ID 461767 - FilelO Plug-ins: Selecting an MXF export preset or selecting an MXF/MQOV write codec
caused Nuke Studio Non-Commercial to crash.

« BUG ID 462393 - FilelO Plug-ins: Loading certain scripts referencing .mov container formats displayed a
Bad alloc error.
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« BUG ID 464134 - Read/Write: Reading DNxHR files with an alpha channel in Nuke Studio did not work as
expected.

* BUG ID 464483 - Sync Review: Cloning soft effects between two sequences in the Host session
invalidated the synched destination shot in Client sessions.

« BUG ID 464867 - Sync Review: Disabling a recently changed soft effect control caused cloned soft effects
to become invalid.

New Known Issues Specific to Nuke 12.2

This section covers new known issues and gives workarounds for them, where appropriate.

Note: Changes to the way motion vectors are calculated in Nuke 12.2 cause any node using the
Local option for motion estimation, such as Kronos and VectorGenerator, to render slightly
different vectors when compared to legacy versions of Nuke. The default Regularized motion
estimation method is unaffected.

» BUG ID 466485 - Linux only: Nuke can not read .r3d files without CUDA libraries available on the
machine.
As a workaround, you can manually install the CUDA libraries from NVIDIA, even if you don't have an
NVIDIA GPU installed.

* BUG ID 465709/463545 - Read/Write: Transcoding .mxf files using the Avid DNxHR codec and an 8-bit
profile does not work as expected.

« BUG ID 465300 - Read/Write: Certain Photo - JPEG encoded .mov files with non-standard format sizes
cause Nuke Studio to crash.

« BUG ID 465045 - Read/Write: The info bar overlay in Nuke Studio's Viewer displays a one frame offset for
.mov and .mxf files compared to the source timecode.

« BUG ID 464508 - Transform: Adjusting the scale control in a Transform node's Properties panel with
show overscan active in the Viewer settings causes Nuke to crash.

» BUG ID 463881 - macOS only: Rendering an .mxf file repeatedly to different channels causes Nuke to
crash.

« BUG ID 461944 - Python: Changing a Read node from an image sequence to a container file format
Pythonically causes Nuke to crash if the Read node has postage stamp set to a static frame.

« BUG ID 460411 - Read/Write: Rereading a .mov encoded with mov32 settings using the file control in
legacy scripts causes Nuke to crash.

* BUG ID 460240 - masOS only: Existing export presets using the deprecated mov32 codecs cause Hiero to
crash on export.
As a workaround, recreate the preset in a Hiero 12.2 release
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« BUG ID 460038 - Particles: Secondary particles emitted from other particles do not render as expected.

« BUG ID 459859 - ACES: Nuke Studio incorrectly allows artists to alter the R3D IPP2 colorspaces in Read
nodes using IPP2 Custom selection, which results in Half Float ACES Linear colorspace mismatches
between Nuke Studio and Nuke.

« BUG ID 459643 - Bookmarks: The bookmark Save Location keyboard shortcuts (Ctrl/Cmd+F7 - F10) are
not working as expected.
As a workaround, right-click in the Node Graph and select Edit > Bookmark > Save Location manually.

* BUG ID 459625 - Workspaces: The Sync Review and Monitor Out workspace keyboard shortcuts
(Shift+F7 and Shift+F8) conflict with Nuke's bookmark functionality.

* BUG ID 448524 - macOS only: The resolution restriction informational message for Nuke Indie contains
incorrect text.

« BUG ID 444347 - Export: Presets that rely on mov32 do not populate the Content field in the Export
dialog.

* BUG ID 443296 - Windows only: The Nuke Indie icon is incorrect.

« BUG ID 442165 - MOV: Writing out .mov files using the H.264 codec at resolutions above the 4K limit
imposed by the codec causes Nuke to crash.

* BUG ID 441979 - USD: Deselecting a group in the USD importer and then enabling view entire
scenegraph does not load the group.

* BUG ID 441555 - USD: Clicking Cancel in the USD import dialog and then enabling view entire
scenegraph does not load the .usd file as expected.

« BUG ID 441439 - R3D: Red decode CPU performance is slower in Nuke 12.2 compared to 12.1 builds.

* BUG ID 440943 - USD: Expanding parent and children groups in the scenegraph manually does not create
the horizontal scroll bar correctly.
As a workaround, right-click and select expand all to display the scroll bar.

* BUG ID 440884 - Sync Review: Clicking the update button in a Client session with Viewer A/B mode
active disconnects the Client.

* BUG ID 440057 - Roaming: Hiero license roaming with a Nuke Studio license stack is not working as
expected.
As a workaround, launch Nuke Studio and select License > Roaming and then set the Workspace to
Conforming.

* BUG ID 439856 - Sync Review: Client sessions do not cache sequences as expected when the Viewer A/B
mode is active on the Host before the Client connects.

* BUG ID 439011 - ApplyMaterial: Selecting filter > name and then clicking choose incorrectly displays
Load state icons.

« BUG ID 439002 - ApplyMaterial: Selecting filter > name and then clicking choose allows editing of the
read-only names in the scenegraph.

« BUG ID 436560/436551 - Sync Review: The formatting in the Sync Session panel and Host and Connect
dialogs is inconsistent.
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* BUG ID 434956 - USD: Columns in the Scenegraph tab can only be rearranged once.

* BUG ID 434574 - File Formats Update: Reading .mxf files in the HybridLogGamma colorspace defaults
to linear incorrectly.

« BUG ID 432438 - Vertex UV values are occasionally displayed incorrectly for .abc and .usd files.

« BUG ID 430779 - File Formats Update: All deprecated IPP2 .r3d colorspaces appear the same as current
colorspaces.

* BUG ID 430760 - File Formats Update: DRAGONCcolor2 and REDcolor4 use the same IPP2 .r3d colorspace.

* BUG ID 429788 - macOS only: Legacy mov32 presets are no longer retained, choosing a preset always
displays the Don't show this message dialog.

« BUG ID 426901 - File Formats Update: In IPP2 Custom mode, enabling the Use GPU checkbox displays
grading controls from the IPP2 Pipeline incorrectly.

« BUG ID 425200 - Read/Write: Legacy Write node Motion JPEG A/B files do not display the Quality
control with mov64 selected as the encoder.

« BUG ID 424070 - RIP: Ops requesting unused inputs occasionally prevent images being released from the
device cache.
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Developer Notes

As Nuke develops, we sometimes have to make changes to the APl and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time APl and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plug-ins and/or make changes to the source code.

Release Type Example Compatibility Recompile Rewrite
Version 12.0v1 to 12.0v2 APl and ABI

Point 12.0v1 to 12.1v1 API

Major 12.0v1 to 13.0v1 -

Additionally, node Class() names occasionally change between major releases. While these changes do not
affect legacy scripts, you may not get the results you were expecting if a node class has been modified.
The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class names and is
located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from CameraShake?2
to CameraShake3. In the toolbars.py file for the two releases, the entries for the CameraShake node
appear as follows:

m.addCommand ("CameraShake", "nuke.createNode (\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand ("CameraShake", "nuke.createNode (\"CameraShake3\")",

icon="CameraShake.png")
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Copyright © 2021 The Foundry Visionmongers Ltd.

Release Date

09 December 2020

Warning: As a result of the current COVID-19 lockdown here in the UK, Foundry cannot
guarantee that our usual high standards of QA have been applied to Nuke's monitor output
functionality, including VR headset support, in this release.

Qualified Operating Systems

« macOS Mojave (10.14) or macOS Catalina (10.15)

Note: We recommend macOS Mojave customers update to 10.14.6 to take advantage of
performance enhancements.

* Windows 10 (64-bit)
» CentOS 7.4 (64-bit), or later

Note: The VFX Platform 2019 upgrade includes library versions that are only compatible with
CentOS 74, or later. Nuke is qualified on the Centos 7.4, 7.5, and 7.6 distributions.

Other operating systems may work, but have not been fully tested.
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If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements.
NVIDIA

An NVIDIA GPU with compute capability 3.0 (Kepler) or above. A list of the compute capabilities of NVIDIA
GPUs is available at https://developer.nvidia.com/cuda-gpus

Note: The compute capability is a property of the GPU hardware and can't be altered by a
software update.

With graphics drivers capable of running CUDA 10.1 or above. On Windows and Linux, CUDA graphics
drivers are bundled with the regular drivers for your NVIDIA GPU. Driver versions 418.96 (Windows) and
418.39 (Linux), or above are required. See https://www.nvidia.com/Download/Find.aspx for more
information.

Note: We recommend using the latest graphics drivers, where possible, regardless of operating
system.

AMD

Note: Bit-wise equality between GPU and CPU holds in most cases, but for some operations
there are limitations to the accuracy possible with this configuration.

« On Windows and Linux, an AMD GPU from the following list:

Note: Other AMD GPUs may work, but have not been fully tested.

« Radeon™ RX 480

« Radeon™ Pro WX 7100
« Radeon™ Pro WX 9100
« Radeon™ Pro WX 8200
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« Radeon™ Pro W5700

Note: For information on the recommended driver for each GPU, see
https://www.amd.com/en/support

» On Mac, AMD GPUs are supported on any late 2013 Mac Pro, mid 2015 MacBook Pros onward, and late
2017 iMac Pros.

Warning: Although AMD GPUs are enabled on other Mac models, they are not officially
supported and used at your own risk.

Multi-GPU Processing

Nuke's GPU support includes an Enable multi-GPU support option. When enabled in the preferences,
GPU processing is shared between the available GPUs for extra processing speed.

Note: Multi-GPU processing is only available for identical GPUs in the same machine. For
example, two NVIDIA GeForce GTX 1080s or two AMD Radeon™ Pro WX 9100s.

New Features

Updates to various file I/0O SDKs can now be installed to override the SDK version shipped with a particular
Nuke build. This allows you to install updates to SDKs for ARRIRAW, Avid, and so on, without updating the
version of Nuke you're running under.

The updates ship as .zip files by operating system, which can be downloaded from our website at:
https://www.foundry.com/products/nuke/download

Warning: Plug-in updates are for Nuke 12.2v4, or later. If you run an incompatible version, such
as Nuke 12.1v3, reading in .mov, .mxf and ARRIRAW files will not work as expected.
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Feature Enhancements

« BUG ID 131139/310593 - Roto/RotoPaint: Columns in the node Properties panel curves table can now
be resized independently.

Bug Fixes

« BUG ID 305293 - Rendering: Nuke's frame server did not render single views from stereo scripts as
expected.

* BUG ID 367592 - CameraTracker: Creating a camera and then undoing the action caused Nuke to crash.

* BUG ID 418171 - Linux only: Right-clicking in the timeline and selecting Editorial > Copy Cuts did not
work as expected.

* BUG ID 431435 - Read/Write: The input/timecode metadata pair displayed incorrect values for .mov files
encoded by R3D Helium cameras.

« BUG ID 433034 - Soft Effects: Text effects above Crop effects were clipped to the bounding box rather
than format.

« BUG ID 439886 - CaraVR: Setting the C_CameraSolver's Cam Projection control to Latlong did not affect
all cameras as expected.

« BUG ID 440488 - USD: Selection behavior for geometry in the ReadGeo scenegraph did not work as
expected.

« BUG ID 441908 - Windows only: Attempting to launch NukeX in --indie mode caused Nuke to crash.

* BUG ID 444858/448037 - Keylight: Using Keylight in Nuke Non-Commercial displayed a licensing error.
* BUG ID 446214 - Keylight: The Screen PreBlur control did not work as expected.

* BUG ID 453598 - Read/Write: Certain .r3d files with 3D LUTs did not load as expected.

* BUG ID 453740 - Documentation: The Hiero PDF user guide did not ship with Nuke releases.

« BUG ID 454221 - Manually saving an .hrox project file during autosave caused Nuke Studio and Hiero to
crash.

« BUG ID 458032 - CaraVR: C_ColourMatcher rendered black frames from certain sequences.

New Known Issues Specific to Nuke 12.2

This section covers new known issues and gives workarounds for them, where appropriate.
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Note: Changes to the way motion vectors are calculated in Nuke 12.2 cause any node using the
Local option for motion estimation, such as Kronos and VectorGenerator, to render slightly
different vectors when compared to legacy versions of Nuke. The default Regularized motion
estimation method is unaffected.

* BUG ID 461944 - Python: Changing a Read node from an image sequence to a container file format
Pythonically causes Nuke to crash if the Read node has postage stamp set to a static frame.

* BUG ID 460240 - masOS only: Existing export presets using the deprecated mov32 codecs cause Hiero to
crash on export.
As a workaround, recreate the preset in a Hiero 12.2 release

« BUG ID 460038 - Particles: Secondary particles emitted from other particles do not render as expected.

* BUG ID 459859 - ACES: Nuke Studio incorrectly allows artists to alter the R3D IPP2 colorspaces in Read
nodes using IPP2 Custom selection, which results in Half Float ACES Linear colorspace mismatches
between Nuke Studio and Nuke.

* BUG ID 448524 - macOS only: The resolution restriction informational message for Nuke Indie contains
incorrect text.

« BUG ID 444347 - Export: Presets that rely on mov32 do not populate the Content field in the Export
dialog.

* BUG ID 443296 - Windows only: The Nuke Indie icon is incorrect.

« BUG ID 442165 - MOV: Writing out .mov files using the H.264 codec at resolutions above the 4K limit
imposed by the codec causes Nuke to crash.

* BUG ID 441979 - USD: Deselecting a group in the USD importer and then enabling view entire
scenegraph does not load the group.

» BUG ID 441555 - USD: Clicking Cancel in the USD import dialog and then enabling view entire
scenegraph does not load the .usd file as expected.

* BUG ID 441439 - R3D: Red decode CPU performance is slower in Nuke 12.2 compared to 12.1 builds.

* BUG ID 440943 - USD: Expanding parent and children groups in the scenegraph manually does not create
the horizontal scroll bar correctly.
As a workaround, right-click and select expand all to display the scroll bar.

« BUG ID 440057 - Roaming: Hiero license roaming with a Nuke Studio license stack is not working as
expected.
As a workaround, launch Nuke Studio and select License > Roaming and then set the Workspace to
Conforming.

« BUG ID 439011 - ApplyMaterial: Selecting filter > name and then clicking choose incorrectly displays
Load state icons.

« BUG ID 439002 - ApplyMaterial: Selecting filter > name and then clicking choose allows editing of the
read-only names in the scenegraph.
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« BUG ID 436560/436551 - Sync Review: The formatting in the Sync Session panel and Host and Connect
dialogs is inconsistent.

* BUG ID 434956 - USD: Columns in the Scenegraph tab can only be rearranged once.

* BUG ID 434574 - File Formats Update: Reading .mxf files in the HybridLogGamma colorspace defaults
to linear incorrectly.

* BUG ID 432438 - Vertex UV values are occasionally displayed incorrectly for .abc and .usd files.

* BUG ID 430779 - File Formats Update: All deprecated IPP2 .r3d colorspaces appear the same as current
colorspaces.

* BUG ID 430760 - File Formats Update: DRAGONcolor2 and REDcolor4 use the same IPP2 .r3d colorspace.

* BUG ID 429788 - macOS only: Legacy mov32 presets are no longer retained, choosing a preset always
displays the Don't show this message dialog.

« BUG ID 426901 - File Formats Update: In IPP2 Custom mode, enabling the Use GPU checkbox displays
grading controls from the IPP2 Pipeline incorrectly.

« BUG ID 425200 - MOV: Legacy Write node Motion JPEG A/B files do not display the Quality control with
mov64 selected as the encoder.

« BUG ID 424070 - RIP: Ops requesting unused inputs occasionally prevent images being released from the
device cache.
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Developer Notes

As Nuke develops, we sometimes have to make changes to the APl and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time APl and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plug-ins and/or make changes to the source code.

Release Type Example Compatibility Recompile Rewrite
Version 12.0v1 to 12.0v2 APl and ABI

Point 12.0v1 to 12.1v1 API

Major 12.0v1 to 13.0v1 -

Additionally, node Class() names occasionally change between major releases. While these changes do not
affect legacy scripts, you may not get the results you were expecting if a node class has been modified.
The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class names and is
located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from CameraShake?2
to CameraShake3. In the toolbars.py file for the two releases, the entries for the CameraShake node
appear as follows:

m.addCommand ("CameraShake", "nuke.createNode (\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand ("CameraShake", "nuke.createNode (\"CameraShake3\")",

icon="CameraShake.png")
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12.2v3

Copyright © 2021 The Foundry Visionmongers Ltd.

Release Date

24 September 2020

Warning: As a result of the current COVID-19 lockdown here in the UK, Foundry cannot
guarantee that our usual high standards of QA have been applied to Nuke's monitor output
functionality, including VR headset support, in this release.

Qualified Operating Systems

« macOS Mojave (10.14) or macOS Catalina (10.15)

Note: We recommend macOS Mojave customers update to 10.14.6 to take advantage of
performance enhancements.

* Windows 10 (64-bit)
» CentOS 7.4 (64-bit), or later

Note: The VFX Platform 2019 upgrade includes library versions that are only compatible with
CentOS 74, or later. Nuke is qualified on the Centos 7.4, 7.5, and 7.6 distributions.

Other operating systems may work, but have not been fully tested.
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If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements.
NVIDIA

An NVIDIA GPU with compute capability 3.0 (Kepler) or above. A list of the compute capabilities of NVIDIA
GPUs is available at https://developer.nvidia.com/cuda-gpus

Note: The compute capability is a property of the GPU hardware and can't be altered by a
software update.

With graphics drivers capable of running CUDA 10.1 or above. On Windows and Linux, CUDA graphics
drivers are bundled with the regular drivers for your NVIDIA GPU. Driver versions 418.96 (Windows) and
418.39 (Linux), or above are required. See https://www.nvidia.com/Download/Find.aspx for more
information.

Note: We recommend using the latest graphics drivers, where possible, regardless of operating
system.

AMD

Note: Bit-wise equality between GPU and CPU holds in most cases, but for some operations
there are limitations to the accuracy possible with this configuration.

« On Windows and Linux, an AMD GPU from the following list:

Note: Other AMD GPUs may work, but have not been fully tested.

« Radeon™ RX 480

« Radeon™ Pro WX 7100
« Radeon™ Pro WX 9100
« Radeon™ Pro WX 8200
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« Radeon™ Pro W5700

Note: For information on the recommended driver for each GPU, see
https://www.amd.com/en/support

» On Mac, AMD GPUs are supported on any late 2013 Mac Pro, mid 2015 MacBook Pros onward, and late
2017 iMac Pros.

Warning: Although AMD GPUs are enabled on other Mac models, they are not officially
supported and used at your own risk.

Multi-GPU Processing

Nuke's GPU support includes an Enable multi-GPU support option. When enabled in the preferences,
GPU processing is shared between the available GPUs for extra processing speed.

Note: Multi-GPU processing is only available for identical GPUs in the same machine. For
example, two NVIDIA GeForce GTX 1080s or two AMD Radeon™ Pro WX 9100s.

New Features

The 3rd party OFX plug-ins, H.264 read and write, and ACC audio restrictions have been removed from
Nuke Indie. See Foundry Learn for more information on Nuke Indie restrictions.

Feature Enhancements

* BUG ID 383567 - A new environment variable, NUKE_DISABLE_FRAMESERVER, has been added to enable
and disable Nuke's Frame Server. Setting a value of 1, disables the Frame Server and 0 enables it.
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Bug Fixes
« BUG ID 132581/418354 - Dope Sheet: Setting a working frame range with Synchronise Frame Range
enabled did not set the same range in the Curve Editor.

* BUG ID 229671 - Linux only: Clicking Import Tracks in the CameraTracker UserTracks tab caused Nuke
to become unresponsive.

« BUG ID 233945 - HieroPlayer: Timelines in autosaved projects could not be edited in HieroPlayer.

* BUG ID 243240 - Timeline Editing: Certain container formats, such as .mov and .mp4, added 1 frame to
the start frame in the timeline when compared to the spreadsheet view.

« BUG ID 388705 - Python: Running a customer garbage cleanup script caused Nuke to crash.

* BUG ID 398188 - Python: Calling nuke.scriptClear() in the Script Editor multiple times caused Nuke to
crash.

« BUG ID 403643 - Linux only: Clicking File > Close Comp before saving caused Nuke to crash.

« BUG ID 418068 - Read/Write: Files written using an Apple ProRes codec produced artifacts when read
using the mov64 decoder.

* BUG ID 428432 - USD: Loading unsupported files failed silently and did not display a warning.

* BUG ID 429293 - HieroPlayer: Clicking Quit in the License Error dialogue caused the application to crash.
« BUG ID 429749 - Reading in QuickTime reference files caused Nuke to crash.

* BUG ID 431921 - Python: Calling hiero.core.projects()[-1].endUndo() caused the application to crash.

« BUG ID 438219 - Python: QComboBox() objects containing items of different lengths were not aligned
correctly.

« BUG ID 438224 - Python: Adding an item to a QComboBox() after creation cut off the text in the sub-
widget.

« BUG ID 439958 - USD: Loading .abc or .usd files occasionally caused the Transform tab controls to be
disabled.

« BUG ID 440295 - Python: Calling addItems() did not update the ReadGeo's scene graph as expected.

« BUG ID 440566 - USD: Toggling an item's parent state off and on did not work as expected.

* BUG ID 441429 - USD: A customer point-instanced .usda file caused Nuke to crash.

« BUG ID 441989 - USD: Loading an unsupported file after successfully loading a .usd file caused Nuke to
crash.

* BUG ID 442045 - Nuke Indie: The application shortcut was named incorrectly.

« BUG ID 443584 - CaraVR: Creating a ParticleEmitter node downstream of a C_GlobalWarp node caused
Nuke to crash.

« BUG ID 443868 - Monitor Output: Certain Blackmagic Design devices occasionally became unresponsive.

* BUG ID 444806 - Sync Review: Switching between sequences with the same name did not update the
timeline and Viewer for client machines.
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« BUG ID 445689 - Create Comp failed silently when the Write node was set to the .mxf file type.

* BUG ID 446406 - Sync Review: Using keyboard shortcuts to set channels in multiple Viewers caused the
channels to become out of sync if a client disconnected and reconnected.

* BUG ID 446419 - Sync Review: Pressing a channel keyboard shortcut twice, such as R, B, or A, did not
revert the channel states as expected.

* BUG ID 446827 - Export: Switching between Hiero export presets with the transcode properties open
displayed and error on the command line.

New Known Issues Specific to Nuke 12.2

This section covers new known issues and gives workarounds for them, where appropriate.

Note: Changes to the way motion vectors are calculated in Nuke 12.2 cause any node using the
Local option for motion estimation, such as Kronos and VectorGenerator, to render slightly
different vectors when compared to legacy versions of Nuke. The default Regularized motion
estimation method is unaffected.

« BUG ID 444347 - Export: Presets that rely on mov32 do not populate the Content field in the Export
dialog.

» BUG ID 443296 - Windows only: The Nuke Indie icon is incorrect.

* BUG ID 442165 - MOV: Writing out .mov files using the H.264 codec at resolutions above the 4K limit
imposed by the codec causes Nuke to crash.

* BUG ID 441979 - USD: Deselecting a group in the USD importer and then enabling view entire
scenegraph does not load the group.

* BUG ID 441555 - USD: Clicking Cancel in the USD import dialog and then enabling view entire
scenegraph does not load the .usd file as expected.

* BUG ID 441439 - R3D: Red decode CPU performance is slower in Nuke 12.2 compared to 12.1 builds.

* BUG ID 440943 - USD: Expanding parent and children groups in the scenegraph manually does not create

the horizontal scroll bar correctly.
As a workaround, right-click and select expand all to display the scroll bar.

* BUG ID 440057 - Roaming: Hiero license roaming with a Nuke Studio license stack is not working as
expected.
As a workaround, launch Nuke Studio and select License > Roaming and then set the Workspace to
Conforming.

« BUG ID 439011 - ApplyMaterial: Selecting filter > name and then clicking choose incorrectly displays
Load state icons.
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« BUG ID 439002 - ApplyMaterial: Selecting filter > name and then clicking choose allows editing of the
read-only names in the scenegraph.

« BUG ID 436560/436551 - Sync Review: The formatting in the Sync Session panel and Host and Connect
dialogs is inconsistent.

* BUG ID 434956 - USD: Columns in the Scenegraph tab can only be rearranged once.
* BUG ID 434574 - File Formats Update: Reading .mxf files in the HybridLogGamma colorspace defaults

to linear incorrectly.

* BUG ID 432438 - Vertex UV values are occasionally displayed incorrectly for .abc and .usd files.

« BUG ID 430779 - File Formats Update: All deprecated IPP2 .r3d colorspaces appear the same as current
colorspaces.

* BUG ID 430760 - File Formats Update: DRAGONcolor2 and REDcolor4 use the same IPP2 .r3d colorspace.

« BUG ID 429788 - macOS only: Legacy mov32 presets are no longer retained, choosing a preset always
displays the Don't show this message dialog.

« BUG ID 429658 - Sync Review: Dragging annotations does not update positions in sync sessions until the
annotation is dropped.

* BUG ID 429656 - Sync Review: Annotation markers in the timeline do not update automatically.
As a workaround, scrub the timeline to force the update.

« BUG ID 426901 - File Formats Update: In IPP2 Custom mode, enabling the Use GPU checkbox displays
grading controls from the IPP2 Pipeline incorrectly.

« BUG ID 425200 - MOV: Legacy Write node Motion JPEG A/B files do not display the Quality control with
mov64 selected as the encoder.

« BUG ID 424070 - RIP: Ops requesting unused inputs occasionally prevent images being released from the
device cache.

« BUG ID 419327 - File Formats Update: DNxHD and DNxHR .mov files do not display different codec
information in the Read node's Properties panel.
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Developer Notes

As Nuke develops, we sometimes have to make changes to the APl and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time APl and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plug-ins and/or make changes to the source code.

Release Type Example Compatibility Recompile Rewrite
Version 12.0v1 to 12.0v2 APl and ABI

Point 12.0v1 to 12.1v1 API

Major 12.0v1 to 13.0v1 -

Additionally, node Class() names occasionally change between major releases. While these changes do not
affect legacy scripts, you may not get the results you were expecting if a node class has been modified.
The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class names and is
located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from CameraShake?2
to CameraShake3. In the toolbars.py file for the two releases, the entries for the CameraShake node
appear as follows:

m.addCommand ("CameraShake", "nuke.createNode (\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand ("CameraShake", "nuke.createNode (\"CameraShake3\")",

icon="CameraShake.png")
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Copyright © 2021 The Foundry Visionmongers Ltd.

Release Date

11 August 2020

Warning: As a result of the current COVID-19 lockdown here in the UK, Foundry cannot
guarantee that our usual high standards of QA have been applied to Nuke's monitor output
functionality, including VR headset support, in this release.

Qualified Operating Systems

« macOS Mojave (10.14) or macOS Catalina (10.15)

Note: We recommend macOS Mojave customers update to 10.14.6 to take advantage of
performance enhancements.

* Windows 10 (64-bit)
» CentOS 7.4 (64-bit), or later

Note: The VFX Platform 2019 upgrade includes library versions that are only compatible with
CentOS 7.4, or later. Nuke 12.1 is qualified on the Centos 7.4, 7.5, and 7.6 distributions.

Other operating systems may work, but have not been fully tested.
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If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements.
NVIDIA

An NVIDIA GPU with compute capability 3.0 (Kepler) or above. A list of the compute capabilities of NVIDIA
GPUs is available at https://developer.nvidia.com/cuda-gpus

Note: The compute capability is a property of the GPU hardware and can't be altered by a
software update.

With graphics drivers capable of running CUDA 10.1 or above. On Windows and Linux, CUDA graphics
drivers are bundled with the regular drivers for your NVIDIA GPU. Driver versions 418.96 (Windows) and
418.39 (Linux), or above are required. See https://www.nvidia.com/Download/Find.aspx for more
information.

Note: We recommend using the latest graphics drivers, where possible, regardless of operating
system.

AMD

Note: Bit-wise equality between GPU and CPU holds in most cases, but for some operations
there are limitations to the accuracy possible with this configuration.

« On Windows and Linux, an AMD GPU from the following list:

Note: Other AMD GPUs may work, but have not been fully tested.

« Radeon™ RX 480

« Radeon™ Pro WX 7100
« Radeon™ Pro WX 9100
« Radeon™ Pro SSG
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« Radeon™ Pro WX 8200

Note: For information on the recommended driver for each GPU, see
https://www.amd.com/en/support

» On Mac, AMD GPUs are supported on any late 2013 Mac Pro, mid 2015 MacBook Pros onward, and late
2017 iMac Pros.

Warning: Although AMD GPUs are enabled on other Mac models, they are not officially
supported and used at your own risk.

Multi-GPU Processing

Nuke's GPU support includes an Enable multi-GPU support option. When enabled in the preferences,
GPU processing is shared between the available GPUs for extra processing speed.

Note: Multi-GPU processing is only available for identical GPUs in the same machine. For
example, two NVIDIA GeForce GTX 1080s or two AMD Radeon™ Pro WX 9100s.

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.

Bug Fixes

« BUG ID 410829 - Linux only: Creating a node from the Python interpreter shipped with Nuke caused the
application to crash.

* BUG ID 442968 - Nuke Indie: Adding a Keylight node to a script displayed a licensing error.

* BUG ID 443058 - macOS only: Adjusting control sliders in Keylight's Properties panel occasionally caused
Nuke to become unresponsive.
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* BUG ID 443268 - Launching Nuke Studio Non-commercial called for a full commercial license.
* BUG ID 443488 - Read/Write: Using a relative file path in Read nodes failed if the ./ prefix was omitted
from the string.

* BUG ID 443628 - Licensing: Nuke set the RLM_ROAM environment variable on startup, rather than the
foundry_ROAM environment variable, which also affected third-party RLM servers.

New Known Issues Specific to Nuke 12.2

This section covers new known issues and gives workarounds for them, where appropriate.

Note: Changes to the way motion vectors are calculated in Nuke 12.2 cause any node using the
Local option for motion estimation, such as Kronos and VectorGenerator, to render slightly
different vectors when compared to legacy versions of Nuke. The default Regularized motion
estimation method is unaffected.

* BUG ID 444347 - Export: Presets that rely on mov32 do not populate the Content field in the Export
dialog.

* BUG ID 443296 - Windows only: The Nuke Indie icon is incorrect.

* BUG ID 442165 - MOV: Writing out .mov files using the H.264 codec at resolutions above the 4K limit
imposed by the codec causes Nuke to crash.

* BUG ID 441979 - USD: Deselecting a group in the USD importer and then enabling view entire
scenegraph does not load the group.

« BUG ID 441555 - USD: Clicking Cancel in the USD import dialog and then enabling view entire
scenegraph does not load the .usd file as expected.

* BUG ID 441439 - R3D: Red decode CPU performance is slower in Nuke 12.2 compared to 12.1 builds.

* BUG ID 440943 - USD: Expanding parent and children groups in the scenegraph manually does not create

the horizontal scroll bar correctly.
As a workaround, right-click and select expand all to display the scroll bar.

« BUG ID 440057 - Roaming: Hiero license roaming with a Nuke Studio license stack is not working as
expected.
As a workaround, launch Nuke Studio and select License > Roaming and then set the Workspace to
Conforming.

« BUG ID 439958 - USD: The Transform tab controls are occasionally grayed-out for certain .usd files.
As a workaround, reload the .usd file.

« BUG ID 439011 - ApplyMaterial: Selecting filter > name and then clicking choose incorrectly displays
Load state icons.
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« BUG ID 439002 - ApplyMaterial: Selecting filter > name and then clicking choose allows editing of the
read-only names in the scenegraph.

« BUG ID 436560/436551 - Sync Review: The formatting in the Sync Session panel and Host and Connect
dialogs is inconsistent.

* BUG ID 434956 - USD: Columns in the Scenegraph tab can only be rearranged once.
* BUG ID 434574 - File Formats Update: Reading .mxf files in the HybridLogGamma colorspace defaults

to linear incorrectly.

* BUG ID 432438 - Vertex UV values are occasionally displayed incorrectly for .abc and .usd files.

« BUG ID 430779 - File Formats Update: All deprecated IPP2 .r3d colorspaces appear the same as current
colorspaces.

* BUG ID 430760 - File Formats Update: DRAGONcolor2 and REDcolor4 use the same IPP2 .r3d colorspace.

« BUG ID 429788 - macOS only: Legacy mov32 presets are no longer retained, choosing a preset always
displays the Don't show this message dialog.

« BUG ID 429658 - Sync Review: Dragging annotations does not update positions in sync sessions until the
annotation is dropped.

* BUG ID 429656 - Sync Review: Annotation markers in the timeline do not update automatically.
As a workaround, scrub the timeline to force the update.

« BUG ID 426901 - File Formats Update: In IPP2 Custom mode, enabling the Use GPU checkbox displays
grading controls from the IPP2 Pipeline incorrectly.

« BUG ID 425200 - MOV: Legacy Write node Motion JPEG A/B files do not display the Quality control with
mov64 selected as the encoder.

« BUG ID 424070 - RIP: Ops requesting unused inputs occasionally prevent images being released from the
device cache.

« BUG ID 419327 - File Formats Update: DNxHD and DNxHR .mov files do not display different codec
information in the Read node's Properties panel.
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Developer Notes

As Nuke develops, we sometimes have to make changes to the APl and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time APl and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plug-ins and/or make changes to the source code.

Release Type Example Compatibility Recompile Rewrite
Version 12.0v1 to 12.0v2 APl and ABI

Point 12.0v1 to 12.1v1 API

Major 12.0v1 to 13.0v1 -

Additionally, node Class() names occasionally change between major releases. While these changes do not
affect legacy scripts, you may not get the results you were expecting if a node class has been modified.
The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class names and is
located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from CameraShake?2
to CameraShake3. In the toolbars.py file for the two releases, the entries for the CameraShake node
appear as follows:

m.addCommand ("CameraShake", "nuke.createNode (\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand ("CameraShake", "nuke.createNode (\"CameraShake3\")",

icon="CameraShake.png")
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Release Notes for Nuke and Hiero
12.2v1T

Release Date

21 July 2020

Warning: As a result of the current COVID-19 lockdown here in the UK, Foundry cannot
guarantee that our usual high standards of QA have been applied to Nuke's monitor output
functionality, including VR headset support, in this release.

Qualified Operating Systems

* macOS Mojave (10.14) or macOS Catalina (10.15)

Note: We recommend macOS Mojave customers update to 10.14.6 to take advantage of
performance enhancements.

* Windows 10 (64-bit)
» CentOS 7.4 (64-bit), or later

Note: The VFX Platform 2019 upgrade includes library versions that are only compatible with
CentOS 74, or later. Nuke 12.1 is qualified on the Centos 7.4, 7.5, and 7.6 distributions.

Other operating systems may work, but have not been fully tested.

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional

requirements.
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NVIDIA

An NVIDIA GPU with compute capability 3.0 (Kepler) or above. A list of the compute capabilities of NVIDIA

GPUs is available at https://developer.nvidia.com/cuda-gpus

Note: The compute capability is a property of the GPU hardware and can't be altered by a
software update.

With graphics drivers capable of running CUDA 10.1 or above. On Windows and Linux, CUDA graphics
drivers are bundled with the regular drivers for your NVIDIA GPU. Driver versions 418.96 (Windows) and
418.39 (Linux), or above are required. See https://www.nvidia.com/Download/Find.aspx for more
information.

Note: We recommend using the latest graphics drivers, where possible, regardless of operating
system.

AMD

Note: Bit-wise equality between GPU and CPU holds in most cases, but for some operations
there are limitations to the accuracy possible with this configuration.

« On Windows and Linux, an AMD GPU from the following list:

Note: Other AMD GPUs may work, but have not been fully tested.

« Radeon™ RX 480

« Radeon™ Pro WX 7100
« Radeon™ Pro WX 9100
« Radeon™ Pro SSG

« Radeon™ Pro WX 8200
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Note: For information on the recommended driver for each GPU, see
https://www.amd.com/en/support

» On Mac, AMD GPUs are supported on any late 2013 Mac Pro, mid 2015 MacBook Pros onward, and late
2017 iMac Pros.

Warning: Although AMD GPUs are enabled on other Mac models, they are not officially
supported and used at your own risk.

Multi-GPU Processing

Nuke's GPU support includes an Enable multi-GPU support option. When enabled in the preferences,
GPU processing is shared between the available GPUs for extra processing speed.

Note: Multi-GPU processing is only available for identical GPUs in the same machine. For
example, two NVIDIA GeForce GTX 1080s or two AMD Radeon™ Pro WX 9100s.

New Features

Nuke 12.2 introduces the ability for artists to “roam” licenses for Nuke, NukeX, Nuke Studio, and Hiero.
License roaming allows floating license servers to “check-out” licenses for use on machines in a node-
locked capacity for up to 30 days, so you can work independently of a license server. Licenses can be
checked out and returned through the Ul, or by setting environment variables.

Note: Checking licenses in and out must be done from the machine you wish to use the license
on, and with a connection to the license server.

To use license roaming you require a Roaming License. Licenses issued Before July 10th 2020 do not
support roaming. New roaming licenses will be issued to customers at Maintenance Renewal time. If you
are in Current Maintenance and would like to upgrade your licenses to take advantage of this new feature,
please submit a request using this form: https://www.foundry.com/nuke-roaming-license
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Note: License Roaming is not currently supported with Production Collective and EDU
Collective licenses.

Once you have received your license and it's installed on the server, you are ready to roam! See License
Roaming on Windows, macOS, or Linux for more information.

Nuke Indie is a single user version of Nuke Studio using a log-in licensing model. Nuke Indie is designed
for personal, small-scale commercial use and includes most of the features of the commercial version of
Nuke Studio.

You can run Nuke Studio in Indie mode using the --indie command line argument. For example, to launch
Nuke Studio in Indie mode on Mac, enter:
/BApplications/Nukel2.2v8/Nukel2.2v8.app/Contents/MacOS/Nukel2.2 --indie

See About Indie for more information.

Sync review allows artists to connect sessions of Nuke Studio, Hiero and/or HieroPlayer and collaborate on
a single project. Each artist has access to the playback controls, annotations, and version system, letting
participants run collaborative review sessions.

Sync Review works by connecting through the machine IP or hostname and through a given open port.
Footage needs to be available for all participants either locally or through a central server. This feature is in
a very early stage of development, but the current functionality may be helpful in the current
circumstances.

See Sync Review for more information.

Known Limitations

» While Nuke Studio, Hiero and HieroPlayer can be hosts or clients, HieroPlayer cannot work as a host for
Nuke Studio or Hiero pre-created projects.

« HieroPlayer can only view annotations, and when creating new annotations from Nuke Studio or Hiero,
the host needs to push the session for HieroPlayer to get the updated annotations.
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Linux Terminal Setup

If the host is a Linux machine, run the following command in the terminal prior to launching Nuke:
sudo iptables -I INPUT -p tcp --dport 45124 --syn -3 ACCEPT

Firewalls

Certain firewall protection, such as macOS, can prevent syncing. Ensure that you allow Nuke to operate
under your network security and privacy settings.

Nuke 12.2 introduces the first part of our USD development for Nuke. It incorporates core USD work and
focuses on the ability to read USD data into Nuke using a ReadGeo node.

We have integrated USD with a dedicated scenegraph, which has support for multi-parent loading and the
ability to view the entire USD scenegraph, just like Alembic. Normals and Color data are also supported, as
well as animated geometry.

See Importing USD Meshes and Point Clouds for more information.

In line with Apple removing support for 32-bit applications, the mov32 Reader/Writer is being deprecated
on all platforms. Along with this change, mov64 has also been replaced with a new MOV Reader and
Writer.

Note: Some of the older QuickTime codecs will no longer be supported as a result of this work.
We would appreciate your feedback on whether any essential codecs are missing.

MOV Reader Updates

« Improved layout and labeling of items

« Improved support for reading .mov files and associated Metadata

« Performance improvements

o AAC Audio support added - Supported formats include .m4a, .mov, and .mp4
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MOV Writer Updates

« Improved layout and labeling of items

« Improved support for Writing .mov files and associated Metadata
« Performance improvements

« New Presets added in Nuke Studio

MOV Writer formats supported (Linux, Win, macOS)

« Animation

o ProRes

« DNxHD

o DNxHR

o H264

« Motion JPEG A
« Motion JPEG B
« MPEG-4

« Photo - JPEG
e« PNG

« Uncompressed

Deprecation of mov32

In Nuke 12.2, the mov32 Reader/Writer is hidden. mov32 is still available using the prefix mov32: in the
file path, however we now recommend using the standard Nuke controls, as mov32 is scheduled for
removal in a future release.

Note: mov32 is not available on macOS Catalina (10.15).

You can now write DNxHR MXF files in Nuke Studio and Hiero, bringing these inline with support
introduced to Nuke 12.1, including OP-Atom and OP-1a Patterns.
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Feature Enhancements

R3D SDK Update

o Red R3D SDK updated to 7.3.1
« Komodo camera support

R3D IPP2 Workflow Improvement

« R3D Image Pipeline has been updated with the addition of an IPP2 custom setting, which allows you
to select your own Primary Color Space and Gamma Curve.

Sony SMDK Update t0 4.19.0

« Improvements to platform compatibility

« BUG ID 420052 - High DPI: Ul scaling options have been added to the Preferences > Behaviors > Ul
Scaling menu.

Bug Fixes
« BUG ID 394981 - C_Blur and Nuke's Blur node did not always produce exactly the same result.

« BUG ID 417542 - Planarlop: Planar inputs connected to a scanline op occasionally released cached images
before all rows had been read, resulting in unnecessary processing overheads.

« BUG ID 422741 - RIP: Images stored in the device cache were occasionally released before being fully
consumed.

* BUG ID 422769 - RIP: Unrequested ops were added as consumers to images stored in the device cache.

« BUG ID 423275/430355 - Replacing %40d notation with %9999d in a file path caused Nuke to crash or
used a large amount of RAM.

« BUG ID 423513 - C_Blender: Operations that reverted to using the CPU rather than GPU caused Nuke to
crash.
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* BUG ID 425382 - Deep: The Viewer was not updated to use DeepTolmage?2 internally.

* BUG ID 428443 - macOS only: Keyboard shortcuts for secondary Viewer inputs, such as Shift+2 to
activate A/B wipe, did not work as expected.

* BUG ID 431560 - macOS only: Scripts containing MotionBlur nodes displayed an error in the Viewer when
playback stopped.

« BUG ID 431815 - C_Blur: Executing a script containing C_Blur nodes from the command line caused Nuke
to become unresponsive or crash.

« BUG ID 438676 - Viewers: Changing the Viewer selection mode did not redraw the selection handles in
the Viewer.

* BUG ID 441750 - Linux only: Setting Output to Repair in F_WireRemoval caused Nuke to crash.

« BUG ID 441945/441953 - Export: Dragging a custom export preset into the project export preset panel
removed the Content column from the Export Structure panel.

New Known Issues Specific to Nuke 12.2

This section covers new known issues and gives workarounds for them, where appropriate.

Note: Changes to the way motion vectors are calculated in Nuke 12.2 cause any node using the
Local option for motion estimation, such as Kronos and VectorGenerator, to render slightly
different vectors when compared to legacy versions of Nuke. The default Regularized motion
estimation method is unaffected.

* BUG ID 442165 - MOV: Writing out .mov files using the H.264 codec at resolutions above the 4K limit
imposed by the codec causes Nuke to crash.

« BUG ID 441989 - USD: Loading a .usd file and then changing the file extension to an unsupported file
type, such as .txt, causes Nuke to crash.

* BUG ID 441979 - USD: Deselecting a group in the USD importer and then enabling view entire
scenegraph does not load the group.

» BUG ID 441555 - USD: Clicking Cancel in the USD import dialog and then enabling view entire
scenegraph does not load the .usd file as expected.

* BUG ID 441439 - R3D: Red decode CPU performance is slower in Nuke 12.2 compared to 12.1 builds.

* BUG ID 441429 - USD: Loading certain .usd files and switching the 3D Viewer selection mode to Vertex
or Face selection causes Nuke to crash.

* BUG ID 440943 - USD: Expanding parent and children groups in the scenegraph manually does not create
the horizontal scroll bar correctly.
As a workaround, right-click and select expand all to display the scroll bar.

61



Release Notes for Nuke and Hiero 12.2v1 |

* BUG ID 440566/440488 - USD: Enabling and disabling parents and children in the scenegraph does not
always work as expected.

* BUG ID 440295 - Python: Calling addItems() does not update the USD scenegraph automatically.
As a workaround, enable and disable view entire scenegraph to force an update.

« BUG ID 440057 - Roaming: Hiero license roaming with a Nuke Studio license stack is not working as
expected.
As a workaround, launch Nuke Studio and select License > Roaming and then set the Workspace to
Conforming.

« BUG ID 439958 - USD: The Transform tab controls are occasionally grayed-out for certain .usd files.
As a workaround, reload the .usd file.

* BUG ID 439011 - ApplyMaterial: Selecting filter > name and then clicking choose incorrectly displays
Load state icons.

« BUG ID 439002 - ApplyMaterial: Selecting filter > name and then clicking choose allows editing of the
read-only names in the scenegraph.

* BUG ID 436998 - Sync Review: The Sync Session menu options should not be available in the
Compositing workspace.

« BUG ID 436560/436551 - Sync Review: The formatting in the Sync Session panel and Host and Connect
dialogs is inconsistent.

* BUG ID 434956 - USD: Columns in the Scenegraph tab can only be rearranged once.

* BUG ID 434574 - File Formats Update: Reading .mxf files in the HybridLogGamma colorspace defaults
to linear incorrectly.

« BUG ID 432438 - Vertex UV values are occasionally displayed incorrectly for .abc and .usd files.

« BUG ID 431643 - Sync Review: Loading a project from a shared network causes the connection to time
out if the host and clients are on different networks.

* BUG ID 430779 - File Formats Update: All deprecated IPP2 .r3d colorspaces appear the same as current
colorspaces.

* BUG ID 430760 - File Formats Update: DRAGONCcolor2 and REDcolor4 use the same IPP2 .r3d colorspace.

» BUG ID 429788 - macOS only: Legacy mov32 presets are no longer retained, choosing a preset always
displays the Don't show this message dialog.

« BUG ID 429658 - Sync Review: Dragging annotations does not update positions in sync sessions until the
annotation is dropped.

* BUG ID 429656 - Sync Review: Annotation markers in the timeline do not update automatically.
As a workaround, scrub the timeline to force the update.

* BUG ID 428432 - USD: Loading unsupported files in a ReadGeo node fails silently and does not display
an error.

* BUG ID 426901 - File Formats Update: In IPP2 Custom mode, enabling the Use GPU checkbox displays
grading controls from the IPP2 Pipeline incorrectly.
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« BUG ID 425200 - MOV: Legacy Write node Motion JPEG A/B files do not display the Quality control with
mov64 selected as the encoder.

« BUG ID 424070 - RIP: Ops requesting unused inputs occasionally prevent images being released from the
device cache.

« BUG ID 419327 - File Formats Update: DNxHD and DNxHR .mov files do not display different codec
information in the Read node's Properties panel.
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Developer Notes

As Nuke develops, we sometimes have to make changes to the APl and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time APl and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plug-ins and/or make changes to the source code.

Release Type Example Compatibility Recompile Rewrite
Version 12.0v1 to 12.0v2 APl and ABI

Point 12.0v1 to 12.1v1 API

Major 12.0v1 to 13.0v1 -

Additionally, node Class() names occasionally change between major releases. While these changes do not
affect legacy scripts, you may not get the results you were expecting if a node class has been modified.
The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class names and is
located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from CameraShake?2
to CameraShake3. In the toolbars.py file for the two releases, the entries for the CameraShake node
appear as follows:

m.addCommand ("CameraShake", "nuke.createNode (\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand ("CameraShake", "nuke.createNode (\"CameraShake3\")",

icon="CameraShake.png")
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